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Word 2011: Settings for Legal 
Professionals 
 

CUSTOMIZING THE STANDARD TOOLBARS 

To customize or Add/Remove Standard toolbars, Ctrl + Click any area of a toolbar 

and choose Customize Toolbars and Menus.  

     

 

 While this dialog box is Open, the toolbars are in an “edit state.”  Click 
and drag any button you wish to remove from a toolbar.  Once it leaves 

the toolbar area, release the mouse and the button will be removed from 

the menu. 

 

 While the dialog is open, a separate menu system (below) appears.   

Choose any function by clicking a menu item and then drag one of the 

buttons to the toolbar to the position desired.  Release the mouse and 

the button will appear on the toolbar. 

 

 

 When your adjustments have been made, click OK on Customize Menus 

And Toolbars Dialog, and the changes will be locked. 
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CUSTOMIZING THE RIBBONS 

The standard ribbons (Home, Layout, Document Elements, Tables, Charts, 

Smart Art, Review and the usually hidden “Developer”) may have their 
display options modified. Chose the “Word Menu”, “Preferences”, click 

“Ribbon.”  
 

   
 

On the Ribbon dialog, choose whether the Ribbon is “On” or “Off” by default, 
or instead Expands when the document opens and contracts later.  Color 

options and actually choosing to display or hide individual ribbons are also 

available. 

 

 
 

Click OK when changes are complete. 
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TURN ON RULERS FOR SHOWING PAGE AND PARAGRAPH MARGINS.  

 Go to the VIEW Menu, and check the Ruler in the lower portion of the 

menu. 

 

 

TURN ON GRIDLINES IN TABLES  

Gridlines are set to OFF by default in Word 2011 making it hard to spot a table in 

a document. You’ll want to turn them on once. Go to the Table Menu and click 

Gridlines 

 

 

CHANGE THE DEFAULT FONT AND LINE SPACING FOR ALL NEW 

DOCUMENTS 

Your IT Department may have already set this in your firm templates and you 

may not be able to change these settings. 

 

1. If you do not have a document open, create a new document that is 

based on the Normal template.  File > New Blank Document 

2. On the Format Menu choose Font.  Make the changes you wish to the 

Font choices to be used as a default going forward, then click the Default 

button in the lower left of the dialog. A second dialog will appear asking if 
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you wish to change the font for all new documents based on the 

NORMAL (blank document) Template.  Click Yes. 

 

   
 

CONFIGURE ADVANCED SETTINGS 

For the following section – you will go to Word> Peferences 

General 

 

The default settings in the General 

Dialog are, well, Generally Acceptable. 

 

If you want your rulers to stay put, you 

should definitely uncheck AutoHide. 
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View 

 

The View Dialog has some interesting 

options: 

Set Field Shading to Always, 

which will make field codes 

like date and page show in 

grey so you know they are 

there. 

Leave Nonprinting characters at 

All, meaning they will show 

and hide when you click the ¶ 

button. 

Increase the Style Area Width to 

at least 1 inch to see Styles in 

the Draft View.  

 

 

Edit 

 

The Edit dialog is usually good by 

default, with one exception.  

Deselect Enable click and type.  

This little feature will, if you click 

in the middle of a blank space, 

insert returns and tabs to force 

you to type at that point.   
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Spelling and Grammar 

 

The Spelling and Grammar dialog hides 

a few very special settings: 

 

Ignore words in UPPERCASE – 

definitely turn that off! 

Ignore words with numbers – up to 

you. 

The Recheck Document button is 

handy if you accidently 

accepted a misspelling by 

mistake and lets you start over. 

 

AutoCorrect and AutoFormat as You Type*** 

 

The AutoCorrect Dialog: 

 

Correct Two Initial CApitals.  This is 

a “type of work” option.  If you 
regularly type AEtna, for 

example, turn it off. 

Capitalize first letter of sentences – 

a true personal preference. 

Replace text as you type – remove 

things from the list that drive 

you crazy.  And hey – add some 

too!  For instance, remove the 

entries that turn this  (c)  into 

this ©, and (r) same for ® 

symbol. 
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The AutomFormat as You Type Dialog. 

 

This is where you control what 

formatting happens without you ever 

wanting it to.   MOST of these should 

be turned off, with a couple of possible 

exceptions: 

 

Straight quotations – if you like 

them curled “left and right” 
leave it on.  If you want them to 

look the same on both ends, 

turn it off. 

Ordinals will look like this:  1st 2nd 

3rd 4th 5th automatically. 

***Remember, even if you don’t get this done, UNDO is your first line of 
defense. 

User Information 

 

The User Information Dialog 

 

This should be appropriately 

filled in for the correct name to 

come up on things like Track 

Changes. 

 

KEYBOARD SHORTCUTS (MAC) 

Function keys  

Note   If you are using a MacBook, to use a function key, you must press the fn 

key (the lower left key on the keyboard) at the same time. 
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To  Press  

Undo the last action  F1  

Cut text or graphics  F2  

Copy text or graphics  F3  

Paste the Clipboard contents  F4  

Choose the Go To command (Edit menu)  F5  

Go to the next pane or frame  F6  

Choose the Spelling and Grammar command (Tools menu)  F7  

Extend a selection  

This keyboard shortcut conflicts with a default Mac OS X key 

assignment. To use this Office keyboard shortcut, you must first turn 

off the Mac OS X keyboard shortcut for this key. On the Apple menu, 

click System Preferences. Under Hardware, click Keyboard. Click the 

Keyboard Shortcuts tab, and then clear the On check box for the key 

assignment that you want to turn off. 

F8  

Update selected fields. 

This keyboard shortcut conflicts with a default Exposé key assignment 

in Mac OS X version 10.3 or later. To use this Office keyboard 

shortcut, you must first turn off the Exposé keyboard shortcut for this 

key. On the Apple menu, click System Preferences. Under Personal, 

click Exposé & Spaces.  Under Keyboard and Mouse Shortcuts, on the 

pop-up menu for the shortcut that you want to turn off, click –. 

F9  

Go to the next field.  

This keyboard shortcut conflicts with a default Exposé key assignment 

in Mac OS X version 10.3 or later. To use this Office keyboard 

shortcut, you must first turn off the Exposé keyboard shortcut for this 

key. On the Apple menu, click System Preferences. Under Personal, 

click Exposé & Spaces. Under Keyboard and Mouse Shortcuts, on the 

pop-up menu for the shortcut that you want to turn off, click –. 

F11  

Choose the Save As command (File menu).  
+ SHIFT 

+ S  

Copy text 
SHIFT + 

F2  

Change letters to upper, lower, or mixed case 
SHIFT + 

F3  

Repeat a Find or Go To action 
SHIFT + 

F4  

Move to the previous insertion point 
SHIFT + 

F5  
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To  Press  

Go to the previous pane or frame 
SHIFT + 

F6  

Choose the Thesaurus command (Tools menu) 
SHIFT + 

F7  

Shrink a selection 

This keyboard shortcut conflicts with a default Exposé key assignment 

in Mac OS X version 10.3 or later. To use this Office keyboard 

shortcut, you must first turn off the Exposé keyboard shortcut for this 

key. On the Apple menu, click System Preferences. Under Personal, 

click Exposé & Spaces. Under Keyboard and Mouse Shortcuts, on the 

pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 

F8  

Switch between a field code and its result. 

This keyboard shortcut conflicts with a default Exposé key assignment 

in Mac OS X version 10.3 or later. To use this Office keyboard 

shortcut, you must first turn off the Exposé keyboard shortcut for this 

key. On the Apple menu, click System Preferences. Under Personal, 

click Exposé & Spaces.  Under Keyboard and Mouse Shortcuts, on the 

pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 

F9  

Display a shortcut menu.  

This keyboard shortcut conflicts with a default Exposé key assignment 

in Mac OS X version 10.3 or later. To use this Office keyboard 

shortcut, you must first turn off the Exposé keyboard shortcut for this 

key. On the Apple menu, click System Preferences. Under Personal, 

click Exposé & Spaces. Under Keyboard and Mouse Shortcuts, on the 

pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 

F10  

Go to the previous field. 

This keyboard shortcut conflicts with a default Exposé key assignment 

in Mac OS X version 10.3 or later. To use this Office keyboard 

shortcut, you must first turn off the Exposé keyboard shortcut for this 

key. On the Apple menu, click System Preferences. Under Personal, 

click Exposé & Spaces.  Under Keyboard and Mouse Shortcuts, on the 

pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 

F11  

Cut to the Spike + F3  

Close the window + F4  

Go to the next window + F6  

Expand or minimize the ribbon 
OPTION + 

+ R  

Insert an empty field + F9  
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To  Press  

Lock a field + F11  

Insert the contents of the Spike 
+ SHIFT 

+ F3  

Repeat a Find or Go To action 
+ SHIFT 

+ F4  

Edit a bookmark 
+ SHIFT 

+ F5  

Go to the previous window 
+ SHIFT 

+ F6  

Update linked information in a Word source document 
+ SHIFT 

+ F7  

Extend a selection or block (then press an arrow key) 
+ SHIFT 

+ F8  

Unlink a field 
+ SHIFT 

+ F9  

Unlock a field 
+ SHIFT 

+ F11  

Create an AutoText  entry 
OPTION + 

F3  

Go to the next window 
OPTION + 

F6  

Find the next misspelling or grammatical error. The Check spelling as 

you type check box must be selected (Word menu, Preferences 

command, Spelling and Grammar). 

OPTION + 

F7  

Run a macro 
OPTION + 

F8  

Switch between all field codes and their results 
OPTION + 

F9  

Go to the previous window 

OPTION + 

SHIFT + 

F6  

Open the Dictionary 

OPTION + 

SHIFT + 

F7  

Run GOTOBUTTON or MACROBUTTON from the field that displays the 

field results 

OPTION + 

SHIFT + 

F9  

Moving the cursor  

To move  Press  
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To move  Press  

One character to the left LEFT ARROW  

One character to the right RIGHT ARROW  

One word to the left OPTION + LEFT ARROW  

One word to the right OPTION + RIGHT ARROW  

One paragraph up + UP ARROW  

One paragraph down + DOWN ARROW  

One cell to the left (in a table) SHIFT + TAB  

One cell to the right (in a table) TAB  

Up one line UP ARROW  

Down one line DOWN ARROW  

To the end of a line + RIGHT ARROW or END  

To the beginning of a line + LEFT ARROW or HOME  

Up one screen (scrolling) PAGE UP  

Down one screen (scrolling)  PAGE DOWN  

To the top of the next page 

+ PAGE DOWN  

+ FN + DOWN ARROW (on a MacBook 

keyboard) 

To the top of the previous page 

+ PAGE UP  

+ FN + UP ARROW (on a MacBook keyboard) 

To the end of a document 

+ END  

+ FN + RIGHT ARROW (on a MacBook 

keyboard) 

To the beginning of a 

document  

+ HOME  

+ FN + LEFT ARROW (on a MacBook keyboard) 

To the previous insertion point SHIFT + F5  

Selecting text and graphics  

Tip   If you know the key combination to move the cursor, you can generally 

select the text by using the same key combination while holding down SHIFT . 

For example, + RIGHT ARROW moves the cursor to the next word, and + SHIFT 

+ RIGHT ARROW selects the text from the cursor to the beginning of the next 

word.  

To extend a selection  Press  

By selecting multiple items that Select the first item that you want, hold down 
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To extend a selection  Press  

are not next to each other , and then select any additional items  

One character to the right SHIFT + RIGHT ARROW  

One character to the left SHIFT + LEFT ARROW  

One word to the right SHIFT + OPTION + RIGHT ARROW  

One word to the left SHIFT + OPTION + LEFT ARROW  

To the end of a line + SHIFT + RIGHT ARROW or SHIFT + END  

To the beginning of a line + SHIFT + LEFT ARROW or SHIFT + HOME  

One line down SHIFT + DOWN ARROW  

One line up SHIFT + UP ARROW  

To the end of a paragraph + SHIFT + DOWN ARROW  

To the beginning of a paragraph + SHIFT + UP ARROW  

One screen down SHIFT + PAGE DOWN  

One screen up SHIFT + PAGE UP  

To the beginning of a document  + SHIFT + HOME  

To the end of a document  + SHIFT + END  

To the end of a window  OPTION + + SHIFT + PAGE DOWN  

To select the entire document  + A  

To a vertical block of text  
+ SHIFT + F8 , and then use the arrow keys; 

press + PERIOD to cancel selection mode  

To a specific location in a 

document  

F8 , and then use the arrow keys; press + 

PERIOD to cancel selection mode  

Selecting text and graphics in a table  

To  Press  

Select the next cell's contents TAB  

Select the preceding cell's 

contents 
SHIFT + TAB  

Extend a selection to adjacent 

cells 

Hold down SHIFT and press an arrow key 

repeatedly  

Select a column 

Click in the column's top or bottom cell. Hold 

down SHIFT and press the UP ARROW or DOWN 

ARROW key repeatedly 

Extend a selection (or block) 
+ SHIFT + F8 , and then use the arrow keys; 

press + PERIOD to cancel selection mode  

Reduce the selection size SHIFT + F8  

Select multiple cells, columns, 

or rows that are not next to 

each other 

Select the first item that you want, hold down , 

and then select any additional items 
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Extending a selection  

To  Press  

Turn extend 

mode on 

F8  

This keyboard shortcut conflicts with a default Mac OS X key 

assignment. To use this Office keyboard shortcut, you must first 

turn off the Mac OS X keyboard shortcut for this key. On the 

Apple menu, click System Preferences. Under Hardware, click 

Keyboard. Click the Keyboard Shortcuts tab, and then clear the 

On check box for the key assignment that you want to turn off. 

Select the 

nearest 

character to 

the left 

F8 , and then press LEFT ARROW  

Select the 

nearest 

character to 

the right 

F8 , and then press RIGHT ARROW  

Expand a 

selection 

Continue to press F8 to expand the selection to the entire word, 

sentence, paragraph, section, and so on. 

Reduce the 

size of a 

selection 

SHIFT + F8  

Turn extend 

mode off  
+ PERIOD  

Editing text and graphics  

To  Press  

Copy text or graphics + C or F3  

Copy a style + SHIFT + C  

Paste a style + SHIFT + V  

Copy text or graphics to the Scrapbook  CONTROL + OPTION + C  

Move text or graphics 
+ X or F2 (then move the cursor and 

press + V or F4 ) 

Insert graphics using the Media Browser  + CONTROL + M  

Create AutoText OPTION + F3  

Insert AutoText + OPTION + SHIFT + V  

Paste the Clipboard contents + V or F4  

Paste the selected clipping from the 

Scrapbook 
CONTROL + OPTION + V  

Paste special + CONTROL + C  
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To  Press  

Paste and match the formatting of the 

surrounding text 
+ OPTION + SHIFT + V  

Paste to the Scrapbook  CONTROL + OPTION + V  

Paste the Spike  contents + SHIFT + F3  

Delete one character to the left  DELETE  

Delete one word to the left  + DELETE  

Delete one character to the right  or CLEAR  

Delete one word to the right  +  

Cut selected text to the Clipboard  + X or F2  

Undo the last action  + Z  

Cut to the Spike + F3  

Aligning and formatting paragraphs  

To  Press  

Center a paragraph + E  

Justify a paragraph + J  

Left align a paragraph + L  

Right align a paragraph + R  

Indent a paragraph from the left  CONTROL + SHIFT + M  

Remove a paragraph indent from the left  + SHIFT + M  

Create a hanging indent + T  

Remove a hanging indent  + SHIFT + T  

Start AutoFormat + OPTION + K  

Apply the Normal style + SHIFT + N  

Apply the Heading 1 style  + OPTION + 1  

Apply the Heading 2 style  + OPTION + 2  

Apply the Heading 3 style  + OPTION + 3  

Apply the List style  + SHIFT + L  

Insert a nonbreaking space OPTION + SPACEBAR  

Setting line spacing  

To set line spacing to  Press  

Single-spaced lines + 1  

Double-spaced lines + 2  

1.5-line spacing  + 5  

Add or remove one line of space directly preceding a paragraph  + 0 (zero)  
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Formatting characters  

To  Press  

Change the font + SHIFT + F  

Increase the font size + SHIFT + >  

Decrease the font size + SHIFT + <  

Increase the font size by 1 point + ]  

Decrease the font size by 1 point + [  

Change the formatting of characters (Font command, 

Format menu) 
+ D  

Change the case of letters SHIFT + F3  

Format in all capital letters + SHIFT + A  

Apply bold formatting + B  

Apply an underline + U  

Underline words but not spaces + SHIFT + W  

Double-underline text + SHIFT + D  

Apply italic formatting + I  

Format in all small capital letters  + SHIFT + K  

Apply subscript formatting (automatic spacing)  + EQUAL SIGN  

Apply superscript formatting (automatic spacing)  
+ SHIFT + PLUS 

SIGN  

Remove manual character formatting  + SHIFT + Z  

Apply strike-through formatting + SHIFT + X  

Inserting special characters  

To insert  Press  

A field + F9  

A line break SHIFT + RETURN  

A page break SHIFT + ENTER  

A column break + SHIFT + RETURN  

A nonbreaking hyphen + SHIFT + HYPHEN  

The copyright symbol OPTION + G  

The registered trademark symbol OPTION + R  

The trademark symbol  OPTION + 2  

An ellipsis  OPTION + SEMICOLON  

Inserting fields  

To insert  Press  

A DATE field CONTROL + SHIFT + D  
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To insert  Press  

A LISTNUM field + OPTION + SHIFT + L  

A PAGE field CONTROL + SHIFT + P  

A TIME field CONTROL + SHIFT + T  

An empty field + F9  

Working with fields  

To  Press  

Update selected fields F9  

Unlink a field + SHIFT + F9  

Switch between a field code and its result SHIFT + F9  

Switch between all field codes and their results OPTION + F9  

Run GOTOBUTTON or MACROBUTTON from the field that 

displays the field results  

OPTION + SHIFT 

+ F9  

Go to the next field  F11  

Go to the previous field  SHIFT + F11  

Lock a field + F11  

Unlock a field  + SHIFT + F11  

Document outline  

To  Press  

Promote a paragraph 

CONTROL + 

SHIFT + LEFT 

ARROW  

Demote a paragraph 

CONTROL + 

SHIFT + RIGHT 

ARROW  

Demote to body text + SHIFT + N  

Move selected paragraphs up 

CONTROL + 

SHIFT + UP 

ARROW  

Move selected paragraphs down 

CONTROL + 

SHIFT + DOWN 

ARROW  

Expand text under a heading 

CONTROL + 

SHIFT + PLUS 

SIGN  

Collapse text under a heading  

This keyboard shortcut conflicts with a default Mac OS X key 

CONTROL + 

SHIFT + MINUS 

SIGN  
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To  Press  

assignment. To use this Office keyboard shortcut, you must first 

turn off the Mac OS X keyboard shortcut for this key. On the 

Apple menu, click System Preferences. Under Hardware, click 

Keyboard. Click the Keyboard Shortcuts tab, and then clear the 

On check box for the key assignment that you want to turn off. 

Expand all body text and headings or collapse all body text 
CONTROL + 

SHIFT + A  

Show the first line of body text or all body text 
CONTROL + 

SHIFT + L  

Show all headings with the specified heading level 

CONTROL + 

SHIFT 

+<HEADING 

LEVEL>  

Reviewing documents  

To  Press  

Insert a comment + OPTION + A  

Turn track changes on or off + SHIFT + E  

Go to the beginning of a comment HOME  

Go to the end of a comment 
END  (The END key is not available 

on all keyboards) 

Go to the beginning of the list of comments 

when in the Reviewing Pane 
+ HOME  

Go to the end of the list of comments when in 

the Reviewing Pane 
+ END  

Printing documents  

To  Press  

Print a document + P  

Moving around in a table  

To  Press  

Move to the next cell 
TAB (If the cursor is in the last cell of a table, 

pressing TAB adds a new row) 

Move to the preceding cell SHIFT + TAB  

Move to the preceding or next 

row 
UP ARROW or DOWN ARROW  

Move to the first cell in the row  CONTROL + HOME  

Move to the last cell in the row  CONTROL + END  
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To  Press  

Move to the first cell in the 

column  
CONTROL + PAGE UP  

Move to the last cell in the column  CONTROL + PAGE DOWN  

Start a new paragraph  RETURN  

Add a new row at the bottom of 

the table  
TAB at the end of the last row  

Add text before a table at the 

beginning of a document  
RETURN at the beginning of the first cell  

Insert a row + CONTROL + I  

Resizing table columns by using the ruler  

To  
Press the shortcut keys, and then drag a 

marker on the ruler  

Retain column sizes to the right  

Change table width  

No key 

Move a single column line  

Retain table width  

SHIFT  

Equally resize all columns to the 

right  

Retain table width  

+ SHIFT  

Proportionally resize all columns to 

the right  

Retain table width  

 

Resizing table columns directly in a table  

Tips    

 To display a column's measurements in the ruler when you resize the 

column, press OPTION with these shortcut keys. 

 To finely adjust a column width, turn off snap-to functionality by pressing 

OPTION with the shortcut keys.  

To  
Press the shortcut keys, and then drag a 

column boundary  

Move a single column line 
No key 
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To  
Press the shortcut keys, and then drag a 

column boundary  

Retain table width 

Retain column sizes to the right  

Change table width  

SHIFT  

Equally resize all columns to the 

right  

Retain table width  

+ SHIFT  

Proportionally resize all columns to 

the right  

Retain table width 

 

Inserting paragraphs and tab characters in a table  

To insert  Press  

New paragraphs in a cell RETURN  

Tab characters in a cell  OPTION + TAB  

Data merge  

To use the following keyboard shortcuts, you must first set up a data merge.  

To  Press  

Merge a document CONTROL + SHIFT + N  

Edit a data-merge data document CONTROL + SHIFT + E  

Check for errors CONTROL + SHIFT + K  

Insert a merge field CONTROL + SHIFT + F  

Footnotes and endnotes  

To insert  Press  

A footnote + OPTION + F  

An endnote + OPTION + E  
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SIGN UP FOR OUR LEGAL TECH NEWSLETTER TO 

RECEIVE MORE GREAT TIPS AND TICKS BY EMAIL  
Click Here to Sign Up 

http://bit.ly/1m4KBv4

